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L E S S O N  5  
 

Publishing a Web 
 
 

O B J E C T I V E S  You will be able to: 
 
 • describe the Internet connections 

necessary to publish a Web. 
 
 • identify methods of publishing a Web 

on a local server. 
 
 • identify methods of publishing a Web 

on a remote server. 
 
 • use the Web Publishing Wizard.  
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In this lesson, you will learn how to publish a Web using FrontPage.  You will learn what 
a Web server is and its function for publishing Webs.  The types of Internet connections 
used for publishing and accessing Webs will be covered.  You will also learn how to 
“serve” your Web using a local and remote server. 

Putting Your Web Online 
 
Although going into the details of Web server administration is beyond the scope of this 
course, there are a few aspects of publishing a Web that should be mentioned.  To 
begin, what is meant by publishing a Web?  At its most basic, publishing a Web means 
giving other users access to your Web pages.  Those users might be on the Internet or 
an internal company network known as an Intranet.  They might access the pages from 
your local computer or a computer to which you upload your files.  Which options you 
choose will depend on the intent of your pages and your audience. 

What is a Web Server? 

A Web server consists of a computer connected to the Internet, loaded with specialized 
software for “serving” files.  In order for all the features of your pages to function 
properly, the pages must be loaded onto a Web server. 

The computer can be virtually any type and be using any of the common operating 
systems (e.g., Unix, Windows98/2002/NT, MacOS, OS/2, etc.).  Obviously, the faster 
the processor the better, but there are Web servers being used that employ everything 
from 486’s to the latest Pentium models.   

What is really referred to as a Web server is the server software application.  It takes in 
requests by Web browsers (client), then fills the request by accessing the files and 
sending them to the client.  This process is accomplished using Hypertext Transfer 
Protocol (HTTP) to communicate back and forth between server and client.   

Other Functions of Web Servers 

Web servers can do much more than just fill requests by browsers.  The common 
functions of Web sites are provided by the Web server software.  Each software 
package will come with a set of features for administering a Web site.  A few of the 
common features are: 

• Processing forms and scripts 
 
The server acts as the “go-between” for taking in the information on a form or 
script and accessing the requested files or data.   

• Providing user messages 
 
When a user tries to access a page that has been moved or no longer exists, it 
is the servers job to supply a message, such as “404:  File Not Found.”   
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• Security 
 
Web servers can be configured for all types of security arrangements.  Most of 
the security involves who is allowed access to the server and what types of 
actions users are permitted to carry out.  Secure Sockets Layer (SSL) is a 
security protocol that encrypts information being passed between the server and 
SSL-enabled browsers.  You may run across SSL if your Web server is used for 
electronic commerce involving the use of credit card numbers or other sensitive 
information.   

FrontPage Server Extensions 

The intent of the FrontPage Server Extensions is to ensure that the pages you create 
with FrontPage will be readable by most Web servers.  For standard HTML pages with 
just text and images, the server extensions are of little concern.  If you use forms, 
connect to a database or use other interactive elements, the server extensions become 
very important.  Most of the more popular Web servers are supported with FrontPage 
extensions and more are being added.  Check the Microsoft Web site for updates and to 
download the extensions (http://www.microsoft.com/frontpage).   

Getting the extensions may be relatively easy, but that does not always mean you will be 
able to use them.  If you use a Web server that is operated by your Internet Service 
Provider (ISP), they may not allow you to load the server extensions.  Before you begin 
creating Web pages that require server extensions, be sure to check with your ISP.  
Sometimes they will permit the use of server extensions, but you may have to pay extra 
or change the type of connection you are using.  If the Web server is operated by your 
organization, then it will be up to the network administrator to decide whether to allow 
the server extensions. 

If you use the Microsoft Personal Web Server (PWS), which can be installed with 
FrontPage, the old server extensions can be installed with that server.  You can use 
Microsoft PWS as your Web server software, but it is a fairly stripped down version of 
server software.  It will not be able to handle the burden of a fully active Web site.  Also, 
the latest FrontPage 2002 server extensions cannot be loaded on PWS, they must be 
installed on a server running Windows 2002, such as Microsoft Internet Information 
Server. 

 

Internet Connections 
 
There are two types of Internet connections you will be concerned with when publishing 
a Web.  First, the connection between you and the Web server.  Second, the connection 
between the Web server and your users. 

Your Connection 

Unless you have personal and direct access to the Web server that is connected to the 
Internet (which certainly has its advantages), you will need to have some sort of 
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connection to your Web server in order to upload your files.  That connection can either 
be accomplished through dial-up or dedicated lines. 

Dial-up 

With dial-up, each time you want to use the Internet, you have to dial into your ISP.  A 
device called a modem allows your computer to communicate with your ISP’s computer 
over standard telephone lines.  Currently, the highest speed modems operate at 56Kbps 
(56 kilobits per second).  That is much faster than older modems, but if you are 
uploading multimedia files, it can be painfully slow.   

Another type of dial-up connection is Integrated Services Digital Network (ISDN).  This 
connection is much faster, up to 128Kbs, and is all digital – making it somewhat more 
reliable for data communications.  Of course the gain in speed and reliability comes at a 
price.  There is usually a fairly hefty installation charge, plus the cost of an ISDN modem 
and connection charges.   

Dedicated 

Dedicated connections are essentially high speed data lines that are always connected 
to the ISP.  Many of these connections are some variety of what is known as a T1 line, 
which carries 1.544 Mbps.  Organizations may have a full T1 or “borrow” part of a T1.  
The bottom line is these connections are very fast and can make your job of sending 
files much easier.  

Other options in this category for the home user include Digital Subscriber Line (DSL) 
and cable modems.  Both are much faster than standard dial-up, but both also have 
their disadvantages.  Cable modem speeds can slow as more users are online because 
you share the line with those other users.  DSL is not available in all communities 
because you must be close to the phone company’s switching center for it to work.  In 
any case, you often hear about the fast speeds of these methods, but something you 
should be aware of is that those speeds are on the download.  Upload speeds, which 
you are concerned with when publishing a Web, are going to be much slower.  

Web Server Connection 

Of primary importance to users of your site is how your Web server is connected to the 
Internet.  Your Web server can use anything from a 14.4Kbps modem to a T3 (45Mbps) 
dedicated leased line.  Obviously, the faster the connection the better.  As the number of 
users increases, the connection will begin to slow. To avoid this situation, use a Web 
server with the highest speed access you can afford.   

There are many options for Web server connections.  You may be able to “rent” space 
for your Web on your ISP.   If you plan on using an ISP to host your site, be sure to 
check out what type of connection they are using and the performance you can expect.   
They should have multiple connections to the Internet, so that if one breaks down the 
others can fill in.   

If you are using the Web site at your organization, you will obviously use whatever 
connection they are employing.  Because most organizations need a fairly high level of 
connectivity, this is often the ideal situation. 
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You can always host your own site.  If you install FrontPage with Microsoft PWS and 
you have even a dial-up connection, that is all you need.  There are many drawbacks to 
this method, but if you are only looking to host a few pages for a very small audience it 
is an option.  The next section will cover how to host your own site using FrontPage.   

Using a Local Server 
 
For the purposes of this course, a local server is a Web server on which FrontPage is 
loaded.  In other words, you are not sending your pages to a remote server. 

Turning Your PC Into a Web Site 

No matter if you have a dedicated or dial-up connection, when you establish a 
connection to the Internet, your Webs can be made available to the world.  All you need 
to do is give out your Internet Protocol (IP) address and anyone can visit your pages. 
The IP address is akin to your phone number on the Internet.  Every computer is 
assigned an IP number and use those numbers to communicate with one another.  The 
format for IP numbers is always four sets of digits separated by dots (periods) that 
range from 0 to 255 (e.g., 129.34.136.9).  Remember that if you do give out your IP 
address, any users of your site will have to deal with the speed of your connection. 

There are a couple of reasons why this arrangement is not desirable for an everyday 
connection.  First, most organizations (dedicated connection) and ISPs (dial-up 
connection) assign IP addresses dynamically.  This means the IP number for your 
computer will constantly change, not allowing you to give out a permanent address for 
your Web server.  It is possible to obtain a permanent IP number from your ISP, but can 
often be quite expensive.  Second, you have to have a permanent IP address in order to 
use a domain name.  A domain name is the “human” name given to the IP number.  For 
example, an IP number might be 127.128.4.136, with the domain name being 
www.mycompany.com.   

Despite those drawbacks, you will still find uses for this method of publishing a Web.  
For example, you might give your IP number to colleagues across the country to have 
them review your pages.  Whatever the reason, to be able to direct users to your 
computer, you must first locate your IP number.  You can use FrontPage to find the 
address by clicking on the Help menu and selecting About FrontPage.  On the dialog 
box that appears, there is a Network Test… button that once clicked, allows you to run 
a test that produces the IP number of the machine you are using.  Once you have the IP 
number, you can then add the Web name and filename to complete the URL (e.g., 
http://127.123.65.109/myweb/webpage.htm).   



 Lesson 5: Publishing a Web 

Designing Web Pages with FrontPage 2002, Part 2  Publishing a Web 
© 2002 by Gestalt Partners LLC - All Rights Reserved 5-5 

 Exercise 5-1:  Locating Your IP Number 

In this exercise, you will locate the IP number of the computer you are using.  If 
possible, you will then give that number to another student to have them access one 
of the pages you created earlier.  Alternately, your instructor may simply conduct a 
demonstration. 

1.  If necessary, make a connection to the Internet. 

There is a good chance you are using a dedicated connection. But if you dialing 
into the Internet, follow your instructors directions on how to connect. 

2.  If necessary, open FrontPage. 

For this exercise, it is not necessary to have a Web open.  

3.  In FrontPage, from the Help menu, choose About FrontPage  

 

Figure 5-1:  About FrontPage  

4.  Click Network Test… 

 

Figure 5-2:  Network Test 

5.  Click Start Test 
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Figure 5-3:  Results of Network Test 

6.  Write down the IP address. 

7.  Click Exit, then OK. 

8.  If possible, give the URL for the frames Web and the frameset.htm file to a 
fellow student. 

For example, http://111.111.111.111/frames/frameset.htm. 

9.  Open Internet Explorer, then type in the URL given to you by another student 
and you should see his/her page. 

 Web Page Design Tip 
Going through FrontPage Explorer is not the only way to find your IP 
number.  In Windows95, click on Start, choose Run…, then type winipcfg 
and click OK.  This produces a dialog box with your IP number. 

 

Installing FrontPage Onto an Existing Server 

Besides using FrontPage to create and test Web pages, it can be loaded directly onto a 
Web server.  Remember that FrontPage is a site management tool as well as a page 
editor.  You may need to install the server extensions, but FrontPage will work with 
many of the popular Web server software packages. 

Once the server extensions are installed, you can log in and administer a server – 
assuming that you have permission.   

Care must be taken when making updates to a “live” server.  Remember that as you 
save files, they are made available to all users (i.e., they are published).  If you want to 
test pages or need approval before making them public, you will probably want to create 
your pages on your own computer, then upload them to a primary server.   

Your IP Address 
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Using a Remote Server 
 
FrontPage acknowledges the fact that you will often create your files locally, then send 
them to a remote server located somewhere on the Internet, by including a Web 
publishing feature.  Without FrontPage, most Web page authors use a File Transfer 
Protocol (FTP) client to upload their files.  FTP is an Internet protocol for sending and 
receiving files.  FTP clients are not terribly complicated, but it is another software 
program to learn.  FrontPage eliminates the need to learn to new software and gives 
you greatly enhanced control over the files you are sending. FrontPage accomplishes 
the sending of files to a remote server using a  “Publish” button. 

The Publish Button 

In FrontPage there is a “Publish” button that is used to send your files to a Web server 
that contains the FrontPage server extensions. Assuming the extensions are installed, 
all you need to do is click on the “Publish” button and type in the name of the Web 
server (e.g., www.isp.com/~username).  You can choose whether you want to send all 
of the pages or only the ones you’ve just changed.  This can save you time, because if 
you just changed a couple of file only those files are uploaded as opposed to the entire 
Web.  You can also access the publishing feature from the File menu, where you can 
choose another site to send your pages to because FrontPage will default to sending to 
the location you first chose. 

If the server extensions are not installed, you can still use this feature to publish your 
Web.  Simply enter the name of the FTP server instead of the Web server.  For 
example, your site on your ISP might be http://www.isp.com/jandoe but for publishing 
you would enter ftp://ftp.isp.com/jandoe (assuming the name of the FTP server is 
ftp.isp.com).  This should cause the server to ask for your username and password.  
Once you’ve entered those items, your files will be uploaded.  If you happen to have any 
content that requires server extensions, at least FrontPage is nice enough to tell you 
about it.  You will receive a message similar to the one below. 

 

Figure 5-4: FrontPage Component Warning 
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 Exercise 5-2:  Publishing a Web 

In this exercise, you will publish a Web to your Personal Web Server.  Normally, you 
would publish to a remote server, but this will allow you to see how the process 
works.  Alternately, your instructor may simply conduct a demonstration. 

1.  In FrontPage, open the frames Web. 

2.  Click on the Publish button. 

 

Figure 5-5:  Publish FrontPage Web Dialog Box 

3.  In the Enter publish destination: field, type http://localhost/frames2. 

This will publish a copy of this Web onto the same Web server, assuming you 
have the Microsoft PWS installed. 

4.  At the warning message about the Web not existing, click OK. 

5.  Click the Show button on the Publish dialog box to view both sites (the current 
and publish to sites). 

 

Figure 5-6:  Publish Web 

All files with a green check will be “uploaded.” 
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6.  Click Options… 

 

Figure 5-7: Publish Options 

Here’s where you can choose to send only pages that have changed.  

7.  Click OK to accept the defaults. 

8.  Click Publish. 

9.  When completed, click the Done button. 

10. From the File menu, select Open Web and you should see frames2 as one of 
the Webs. 

To test the publishing of only changed pages, you can open the frames Web, 
change something on one of the pages, then publish and only the page you 
change should be uploaded. 

 

Review 
 
In this lesson, you learned what is involved in having your Web pages published.  You 
have been introduced to the functions of a Web server.  You also learned the Internet 
connections that are available to you and your users.  You located your IP number for 
use in serving your pages to other users and used the “Publish” button to publish a Web 
to your Personal Web Server. 


